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aCI Take complete control

Eﬁ over all your Domino
server ACLs.

Ytria aclEZ gives you a quick

overview of all the ACLs on a

server, plus it lets you mass-edit

settings, manage roles, explore

groups and more.

Ytria aclEZ gives you a bird's eye view of server
ACLs. Here's how:
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R@adEZ: see all the ACL on a server |

Once you select a server you can see all its
ACL information: When you first launch aclEZ, you need to
choose a server in the File menu. Once a server is loaded, the
Databases pane (on the left) will list all the databases on the
selected server. Ytria aclEZ will load the ACL information for any
databases checked in this pane. Here is a quick overview of how
aclEZ presents this information:

The main aclEZ

Members of group Group MP - Administrator, 2 \E||z|

Server: |v|| Set Default |

Look ire  Demo2's Address Book hd

Enable group navigator (explare nested graups and not anly the top level]

" Tree Layout | Grid Layout
= _Group MP - Administrator 2
- armandn AmesfDemoZ
: irby ArroyvofDemo
(= _Group MP - Administratar 1
- awnulfa abraham/Demoz
Ranny Abbaott/Demaz
Maddison MannfDemoz
Matilda Mann/Demoz2
Cleveland Manning/Demoz
Merwin Washington/Demaz
iaregory WarnerjDemoZ
James Joyce/Demo2
- Finlay Joyce/Demo2
‘- Roosevelt Joseph/Demoz

~Mathew Ziegler/Demo2

Freya Young/Demoz
- Lea Woods/DemaZz
+ Josh WilisiDemoz

Courtney Whittaker/Demoz
~ Mauricio \Werner/Demao2
~ Moah WattsfDemoz

clEZ v9.1.0.11 - Demo2/Demo2

File  Panels

Search  Options  Tooks  Help

Databases 2 x [ACL Entries - 130 databases curently listed - 3 names currently selected
= (W] || Demoz/Demoz (130134
] ddCharts (1/1)

(] Demo (2/2) k" <7 |Database Title T %¥ ||<F |DatabaseFile <7 Mame

] help (7i7) & Server Certificate admin Y certsrv.nsf CtherDomaingervers [ [- WaRN
] iNokes (33)

Drag a column header here ko group by that content,

] mp (66 & Server Certificate Admin

el (303 & server Certificate admin certsrv.nsf Anonymous R Unspeciied
& Bstes.nsf = @ Server Certificate Admin certsrv.nsf LocalDomainServers JLocalDomainServers EF server Grou
JLocalbomainservers. .. EF server Grau

& propunsf 3 Server Certificate Admin certsrv.nsf LocalDomainServers (=] *[YTRIA JLocalDomainServersf... L& Server Grou

certsrv.nsf LocalbomainServers [ Process MP{Demo2 JLocalDomainServers EE server Grou

i Hierarchy
ING: Group ... [OtherDomainServers 5F server Gron

& certsrv.nsf

|
|
& madrmin.nef & Server Certificate Admin \ certsrv.nsf LocalDomainServers
|
|
BB activity.ntf E rtificate Admin e f iy | [MMunspeciied
G admind.nsf <D Server Certificate Admin Y\ certsrv.nsf Demoz/Demoz DemazjDemoZ ! £ server
V] |EH admin.ntf @ Server Certificate Adh y trv.nsf Administrat (2] Mister adminfDeme2 [Administrat U fied
© AgentRunner s erver Certificate Admin certsry.nst iniskr akors ister Admin/Derno: miristrators nspecifie
B alege i : & Server Certificate Admin V' cerksrv.nsf Administrators [ #1vTRIA Administrators Urspecified
- e | s T W :
< Base_Preview.nst BB Server Certificate Admin | carvSount -Default- -Default- Unspecified
IR tilng.ntf BB server Certificate Admin Yy eSOt [OtherDomainServers] [~ [- ERROR: Group do...  [[OtherDomainServers] EF server Gra
& bookmark.nsf m Server Certificate Admin § csrvS0,ntF CtherDomainServers D [- WARMING: Groupi.. [OtherDomainServers Unspecified
[ bookmark.ntf 5 te Admin } ntf I
G busytime.nsf BB server Certificate Admin \ CsrvS0,nkF [LocalDomainServers] [ [- ERROR: Group do... [[LocalDomainServers] EF server Gra
E husgt\mtzf.ntf m Server Certificate Admin i csrwSi.ntf LacalDomainServers D Demoz/Demaz [LocalDomainServers Unspecified
@ E:;Eg s m Server Certificate Admin i csrwSi.ntf LacalDomainServers D Mister admin/Demoz  [LocalDomainServers/... Unspecified
a Eata\uq‘ntf m Server Certificate Admin i csrwSi.ntf LocalDomainServers m *YTRIA [LocalDomainServers/... Unspecified )
I i bl
B ccaso.ntf
B certlog.ntf Roles 88
B certpub.ntf
B certrequnif Drag a column header here b group by that cantent.

JE— A \Name(s) AFF. T \Ro\e Assign... =7 |Database Title: E'g |Database Path A \Database File: Fid |Role (]
4 ' 203 D O Administration Requests (RS) 1 admin4.nsf 41 E
csrw50.ntf 2i3 = Adrninistrabion Requests (RS) 1\ admin4. nsf [l@#geat(_{{H{]
S 4580, 203 B O Adrinistration Requests (RS) 1 admin4. nsf [UserCreatar]
~[v] [ dbe.ntf = 2i3 =) Adrninistration Requests (RS | adming. nsf [UserMadifier]
- -l citfirman ”;FI e EETE) = ] Adrministration Requests (RS) | admind, nsf [GraupCreatar] 3
DatobasesckctighFiter ¥ | %) L | 5
ACL Entry Selactifin Filer ¥ 0utput|Atthutes\ACL Entry Presence |Roles | Global ACL Properties
Ready UM

When you select ACL entries in aclEZ's ACL Entries pane, the database to which they

belong will be shown in boldface in the Databases panel

The Group

Expander button in
aclEZ lets you see
all the members of
a group in an ACL

The ACL entries pane
in aclEZ

If you enable the ‘Expand
Nested Groups’ function
in the Options menu of
aclEZ, you'll see all of a
group's members in the
ACL Entries pane. Group
members will have a pink
background




Ytria aclEZ gives you an in-depth overview
of ACL information: The ACL Entries pane lists all the
selected databases' ACLs. This pane supports grouping—
just drag a column header to the gray area to sort ACL
information by any category you wish.

ACL Entries - 66 databaszes currently listed - Ho name cumrently selected
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Status = |ﬂ |Database Title
|=] Name : -Default- (66}
Access : 0 - No Access (8)
Access : 1 - Depositor {2}
Access : 2 - Reader {42)
Access : 3 - Author (4)
Access : 4 - Editor (1)
Access : 5 - Designer {2) -
Access : 6 - Manager {7}
Name : [-Default-] (43)
Name : [-Default] {1}
Name : [Anonymous] {18}
Name : [LocalDomainCatalogServers] (1)
Name : [LocalDomainServers] (42)
Name : [OtherDomainServers] {41)
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1.1.17  Grouping ACL Entries in aclEZ. In this example we can

see that seven selected databases are set to give Manager
Access by default

Quickly make changes to Access levels and
privileges: From the Attributes panel you can make
mass-modifications to Access level and privileges to

groups or individuals selected in the ACL Entries pane.
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1.1.2 The aclEZ Attributes panel

[E] Read Public Documents
[E] ‘wirite Public Documents

[E] Create Documents
[E] Delete Documents

[E] Create Private Agents [E] Replicate or Copy Documents

See who has what role: The Roles panel lists
detailed information about all the roles present in the
databases whose checkboxes you've ticked in the
Databases panel. If you select one-or-more entries in the
ACL Entries pane, the Roles panel will tell which names
have a given role assigned to them through the checkbox
in the Role Assignment column. If it's checked, the role is
assigned to the selected names; if unchecked, the role is
not assigned to the names; if the box is filled-in or
indeterminate, the role is assigned to one-or-more but
not all selected names; or if the whole cell is grayed-out,
the role is not available in the selected names. You can
click the Role Assignment checkbox to toggle role
assignment for the selected names.

Where you have a heterogeneous selection of names,
the ‘Names Affected’ column shows which names have a
particular role available in their ACL.

The right-click menu in the Roles panel lets you define
new roles (with the ‘New Role’ contextual menu option),
as well as rename or delete existing roles.
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1.1.4 The aclEZ ACL Entry Presence panel

See where an ACL entry is present: The
ACL Entry Presence Panel will reveal whether selected

ACL entries are present in any given database. This panel
supports grouping by dragging column headers. Here is
an example of how you might put this feature to good
use: In figure 1.1.4 the selected name in the ACL Entries
pane is the “Administrators” group, so in the seven
databases where the Presence is Unchecked there is no

Administrators group.
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1.1.3 The aclEZ Roles panel
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With agentEZ you get a quick overview of Q)
2 ACL settings; it lets you edit, mass-edit or Note: When you modify an agent in agentEZ
you'll see a pencil icon ( & Madffied ) but in order for
. the changes to actually be applied to your server you
Here's how: must click Ctrl+S or select “Apply Changes”in the
File menu.

even copy and paste ACL entries.

See and change all your ACL entries: In the
ACL Entries pane you can also manually adjust access settings. ACL Entries - 7 databases currently listed - 1 name currently selected

Database Title fu

E You can create new ACL entries: In the ACL

Entries pane you can also add new ACL entries by right-clicking reate Shared FolderfViews <7 |Create LS{Java Age... =7 |Read Public Docume... 7 |Write Public Docume... <7 |Replicate or Copy Dacume, ., 2 %
an entry and selecting New ACL Entry (based on current =l Database Title : Database Analysis (12)
selection) in the contextual menu. A window will appear [F] F]
where you can name this new ACL entry (see Figure 2.2). F | 3
The new ACL entry will be created with the same attributes i
as the entry that you originally right-clicked. Whenever you
use the New ACL Entry option on a multiple selection, aclEZ
will give the new entry the same attributes as the topmost b
entry in the selection.

o = =

Fieal Value: D

ToDoS N _ _

=l Database Title : Design Synopsis Template (13)

| Addiess book... | | ok | | Cancel | D D
2.2 This dialog appears for aclEZ's New [l ol
ACL Entry (based on current selection) £ u | 3
option 2.1 Inthe ACL Entries pane you can scraoll to the right to see and modify access settings with checkboxes

Mew ACL Entries (Based on current selection)...
BEE] veria aciEZ lets you copy and paste ACL N ST—
entries between databases: If you right-click a name Delete Selected ACL Entries
in the ACL Entries pane there is a Copy Selected ACL Impert ACL Frarm... oy Petstone e e —— ]
Entries to... option in the resulting contextual menu. Export AL Tau.. I Presence : Unchecked (23) ‘
When you click Copy Selected ACL Entries to... Relosd Databsse o L
(Figure 2.3a) aclEZ will copy the selected entries' ACL R AR R Bl oo o Adinitration Requests (£S) |
. . . . Administration Requests (R5) |
settings and a dialog box (Figure 2.3b) entitled ‘Copy Shan Group Members... — \
Element(s)’ will appear. Use this dialog to choose where e e e 4 e e
to copy the ACL entries. Please note that ACL entries with tncheck Datahases For Seected Entres T ] &
the same name can have very different settings so be ek Databases P Entes ok elected R |
careful to choose the correct entries. z:: 2:';:”; \ _ - =
2.3b  The ‘Copy Elements to’ dialog box in aclEZ.
2.3a The ‘Copy Selected ACL Entries This is where you choose the databases to which
to’ contextual menu option in aclEZ you'll copy ACL settings.
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Plus there's support for Full Access
3 Administration, a tool for exploring NAB
groups, a Global ACL Properties viewer and
more... Here are just a few of the other
features:

Bl See advanced ACL information for all
databases on a server at once: In the Global ACL
Properties tab you can see all the information you'd find
in the ‘Advanced’ and ‘Log'tabs in the Lotus Notes Access
Control dialog. But unlike Notes, aclEZ lets you see this
information for many databases at the same time. Just
select all the databases whose advanced ACL information
you'd like to see in the Databases pane and the information
will appear in the Global ACL properties tab, each line
representing the ACL properties on a database. The
information in this tab is laid out in an easy-to-read grid.
You can also right-click one-or-more entries and choose
Edit Element to modify the Administration Server settings
for your selection.

Enforce ACL Across All Replicas /1

S.. %7 |History <V |Database Title 7 |Database File x¢ |Administration S... © <7 |Modify
=) Enforce ACL Across All Replicas : Unchecked (104)

MP Log mp_mplog.nsf  MMCTNSO1/VIA Modify all Readers and Author... Editor

(-] Notes Log (Demo2jDemo2)  log.nsf Editor

(-] Demo2's Address Book names.nsf i Editor

(=) Activity Trends (6) activity.ntf

(=] Administration Requests (RS) admind.nsf

(=] Administration Requests (6)  admind.ntf

Do not modfy Names fields  Editor
Do not modify Nemes fields  Editor
Do not modify Nemes fields  Editor

(-] 3ava AgentRunner AgentRunner.nsf Do not modify Names fields Editor
() Agent Log alog4.ntf Do not modify Names fields Editor
(=] Archive Log (6) archigS0.ntf Do not modify Names fields Editor
(-] Biling billing.ntF Do not modify Names fields Editor

bookmark.nsf Do not modfy Names fields ~ Editor
(-] Bookmarks (6) boakmark.ntf Do not modify Names fields Editor
(-] Local free time info Do not modify Names fields Editor

busytime.ntf
< i

| >

and Author %7 |Max Internet Nan &

3

E Explore the groups in a Notes Address
Book: The NAB Group Navigator can be found in aclEZ's
Tools menu. This feature lets you see all the groups and

group members on a server's NAB, including nested groups.

The NAB Group nativator lets you see a server's group
information in either a‘Tree’ layout or a grid.

All groups on Demo2/Demo2 in Demo2’s Add

- Set Default

Demo's &ddress Book <

Server.  Demo2/Demo2

Look in:

Enable group navigator (explore nested groups and not only the top level)
Girid Lapout
Crag 4 column header here ko hat content

MName < |Members 5 )
_Graup IS Motes Designers Mally Marsden/Demaz Bl
_Group IS Notes Designers Robby Goadrich/Demoz

_Group IS Notes Designers Robert Elliott/Demoz

_tGroup IS Mokes Designers Tia Forster/Demo2

_Group MP Glen AaronfDemoZ

_Group MP Ernma Abbotk/Demoz

_tGaroup MP Freddie Abbott/Demoz

_taroup MP Jack abbott/Demoz |
< i | =

LCloze

Output | Attributes | ACL Entry Presence |Roles | Global ACL Properties |

The Global ACL Properties panel lets you see advanced
ACL information and change administration server
settings.

E Ytria aclEZ supports Full Access
Administration: Just click Options>Full Access
Administration to turn on this feature. The aclEZ
implementation of Full Access in no way circumvents Notes
security, therefore in order to use Full Access Administration
in aclEZ (or any of our tools for that matter) you must be
listed as a Full Access Administrator on the server; this is set
in Domino Administrator.

Cptions | Tools  Help

Read Database Immediately upon Selection
Read Database only when ‘Apply' Button is Clicked
Database Files 4

Group Expander 4

| Full Access Adrninistration. , ™

T !

3.3 aclEZ's title bar will remind you if Full Access
Administration is turned on
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